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Legal Notices
Condrey Corporation makes no representations or warranties with respect to the contents or
use of this documentation, and specifically disclaims any express or implied warranties of
merchantability or fitness for any particular purpose. Further, Condrey Corporation reserves
the right to revise this publication and to make changes to its content, at any time, without
obligation to notify any person or entity of such revisions or changes.

Further, Condrey Corporation makes no representations or warranties with respect to any
software, and specifically disclaims any express or implied warranties of merchantability or
fitness for any particular purpose. Further, Condrey Corporation reserves the right to make
changes to any and all parts of the software at any time, without obligation to notify any
person or entity of such revisions or changes. See the Software EULA for full license and
warranty information with regard to the Software.

Any products or technical information provided under this Agreement may be subject to U.S.
export controls and the trade laws of other countries. You agree to comply with all export
control regulations and to obtain any required licenses or classification to export, re-export,
or import deliverables. You agree not to export or re-export to entities on the current U.S.
export exclusion lists or to any embargoed or terrorist countries as specified in the U.S.
export laws. You agree to not use deliverables for prohibited nuclear, missile, or chemical
biological weaponry end uses. Condrey Corporation assumes no responsibility for your
failure to obtain any necessary export approvals.

Copyright © 2025 Condrey Corporation. All Rights Reserved.

No part of this publication may be reproduced, photocopied, or transmitted in any fashion
without the express written consent of the publisher.

Condrey Corporation
120 North Laurens St.
Greenville, SC 29601
U.S.A.

https:/ / condreycorp.com/
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Third-Party Systems
The software is designed to run in an environment containing third-party elements meeting
certain prerequisites. These may include operating systems, directory services, databases,
and other components or technologies. See the accompanying prerequisites list for details.

The software may require a minimum version of these elements to function. Further, these
elements may require appropriate configuration and resources such as computing, memory,
storage, or bandwidth for the software to be able to perform in a way that meets the
customer requirements. The download, installation, performance, upgrade, backup,
troubleshooting, and management of these elements is the responsibility of the customer
using the third-party vendor’s documentation and guidance.

Third-party systems emulating any of these elements must fully adhere to and support the
appropriate APIs, standards, and protocols for the software to function. Support of the
software in conjunction with such emulating third-party elements is determined on a case-by-
case basis and may change at any time.
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About This Guide

About This Guide
This guide provides the procedures to install and use File Reporter 25.3 Client Tools. It is
intended for network administrators who manage network storage resources, and for data
owners who are responsible for reporting on metadata and permissions for unstructured
data in Windows file systems and Microsoft 365 document libraries in OneDrive for Business,
SharePoint Online, and Teams collaborative environments.
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1 - Minimum Requirements

1 - Minimum Requirements
l Any 64-bit multi-core processor Windows workstation (the number and speed of

available cores may directly impact significant workloads using the Data Analytics
tool).

l .NET 9.0 Desktop Runtime (will be installed if not already present).

l A DirectX 10-compatible graphics card required for use with the Data Analytics tool.

l 8 GB RAM for Report Viewer (depending on the size of report loading, exporting, and
processing, you may need significantly more RAM).

l 12 GB RAM for Data Analytics

NOTE: A minimum of 1 KB per scan data entry (or 1 GB per million
entries) is required for the Data Analytics tool. Depending on the type of
analysis conducted (e.g., Pivot Grid) and the number of entries in a
single scan, you may need significantly more RAM.

l 250 MB disk space

l Report Designer and Data Analytics users must be members of the SrsAdmins group.
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2 - Installing the Client Tools

2 - Installing the Client Tools
1. Copy the FileReporter-ClientTools-25.3-x64-xx.exe file from the root of the

FileReporter-25.3.iso image to all Windows workstations that will run the Client
Tools.

2. Double-click FileReporter-ClientTools-25.3-x64-xx.exe from the Windows workstation.

3. Agree to the license terms and conditions, then click Install.

4. When notified that the setup was successful, click Close.

Icons for Data Analytics and Report Designer icons are added to the Start menu.
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3 - Installing the Report Viewer

3 - Installing the Report Viewer
1. From the root of the FileReporter-25.3.iso image, copy the FileReporter-

ReportViewer-25.3-x64-xx.exe file to all Windows workstations where you will
run the Report Viewer.

2. From the Windows workstation, double-click FileReporter-ReportViewer-
25.3-x64-xx.exe.

3. Agree to the license terms and conditions, then click Install.

4. When notified that the setup was successful, click Close.

The Report Viewer icon is added to the Start menu.
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4 - Data Analytics Tools

4 - Data Analytics Tools
File Dynamics's Client Tools provide members of the administrators group expanded abilities
to analyze data and design reports. Run from a Windows workstation, the integrated set of
data visualization applications include a Dashboard, Pivot Grid, and Tree Map.

To use the Data Analytics Tools, you must first perform a File System metadata scan for
each Scan Target you want to analyze —see Creating A Scan Policy in the File Reporter 25.3
Administration Guide for details on setting up a File System scan.

4.1 - Using the Analytics Tools

The following procedures introduce some of the capabilities of each application. You can
discover more capabilities as you work with the applications.

1. Select File Reporter 25.3 Data Analytics in the Start menu to open the login screen:

2. Enter your login credentials and click Login to open a selection dialog:

3. Expand the shares and volumes.
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4 - Data Analytics Tools

4. Double-click the File System scan you want to analyze to view the scan data in the
Dashboard.

4.2 - Using the Dashboard

NOTE: The following exercises introduce the basic features of the Analytics
Tools. Familiarize yourself with these features to become proficient enough
with the tools to try more advanced features.

1. Uncheck one or two of the boxes in the Filters region of the Dashboard to observe how
the changes are reflected in the Summary Data, Top Extensions by Size, and Summary
regions.
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4 - Data Analytics Tools

2. Click a specific year in the Files Created by Year region to observe the changes in the
Summary Data, Top Extensions by Size, and Summary regions of the Dashboard.

These graphical displays are driven by the Filters region and the selected years from
the Files Created by Year and Files Modified by Year regions.

3. Move your cursor over a pie graph section in the Summary Data region to observe how
specific information about the section appears in a balloon.

4. Double-click a pie graph section and observe how the Dashboard drills down to show
data specific to the selected section in the Summary Data, Top Extensions by Size, and
Summary regions.

5. Right-click a section of the new pie graph and select Details Grid to view the individual
filenames.

6. Right-click a file from the grid and select Open Folder to open the folder where the file
is located. The Dashboard provides the ability to access any files easily.

7. Close the grid.

8. Click the drill-up arrow (3) for the Summary Data region of the Dashboard to return to
the originally-displayed data.

9. Move your cursor over one of the bars in the Top Extensions by Size region to observe
how specific information about the section appears in a balloon.

10. Right-click and select Export to Image in the Top Extensions by Size region.
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4 - Data Analytics Tools

11. Save the image to a location on your desktop to insert as a graphic in a presentation or
report.

12. Double-click a year span in the Files Created by Year region to observe how the
displayed data in the other regions is updated to data pertaining to the selected year.

13. Right-click the selected year span and select Clear Master Filter to view the graph span
of all the years again.

14. Double-click a year span in the Files Modified by Year region to observe the change in
the displayed data in the Dashboard.

15. Move your cursor over a bar in the Top Extensions by Size region, then right-click and
select Print Preview. Note that you can save the graph as a PDF or email the graph, in
addition to printing it.

16. Close the Print Preview page.

4.3 - Using the Tree Map

View graphical representations of hierarchical file system data in the Tree Map to gain
insight quickly.
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4 - Data Analytics Tools

1. Click Load from Database in the Dashboard.

2. Double-click the desired file system scan.

3. Click Tree Map.

4. The Tree Map is presented according to file extension type with the specific color
assignments detailed in the File Extension region. Each square in the Tree Map
represents a single file in the scanned storage resource according to file size, relative
to all other files in the scan.

5. Click a larger square to view the details of the file in the Properties region.

6. Right-click the file and select Open Parent Folder to open the folder in which the file
resides.

7. Expand the file system so it is displayed in the Folders region.

8. Click one of the folders to see the group of files that reside in that folder. The files
belonging to a selected folder are outlined in magenta.

9. Right-click a folder and select Set Scope to drill down and view the contents of the
folder in the Tree Map.

10. Right-click the listed scan in the Folders region and select Reset Root Scope.

11. Click Owner to display files according to owners in the Tree Map and observe which
users are storing the largest files according to the color classifications.

12. Click Access Date in the Date Range menu to view the data in the Tree Map according
to when the files were last accessed. This is one of the most powerful methods in File
Reporter of quickly determining the relevance of data being stored on network storage
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4 - Data Analytics Tools

resources.

4.4 - Using the Pivot Grid

Visually analyze data according to combinations of variables in the Pivot Grid.

1. Click Load from Database in the Dashboard.

2. Double-click the desired file system scan.

3. Click Pivot Grid.

4. Select Size (residing in the Measures folder) from the Pivot Fields region and drag it to
the area marked Drop Data Items.

5. Again in the Pivot Fields region, select Owner and drag it to the area marked Drop Row
Fields Here.

6. Observe the totals now calculated for the two data variables.
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4 - Data Analytics Tools

7. Expand Access Time to locate Access Time (Month) in the Pivot Fields region and drag
it to the area marked Drop Column Fields Here.

8. Click the filter icon from the Access Time (Month) filter that you just placed.
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4 - Data Analytics Tools

9. Deselect all but one month and click OK.

10. Click the Chart tab.

11. Highlight three consecutive rows to view the data analyzed as graphs in the Chart
region.

12. Experiment with different chart views of the data using the Chart Presets options.

13. Double-click a selected cell from the table to access the Scan Data Details table, which
specifies all files accessed by that user during that month.
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4 - Data Analytics Tools

14. Right-click a file From the Scan Data Details table, and select Open Folder to open the
parent folder and examine the file, move it to another location, or delete it.

15. Click the Reports tab.

16. Highlight three consecutive rows.

17. Click Generate Report.

18. You can print the report or export it to several different formats.
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5 - Report Designer

5 - Report Designer
Design reports locally from a Windows workstation and add significantly more design
capabilities to the report features found in the browser-based administrative interface.

5.1 - Using Report Designer

NOTE: You must be a member of the SrsAdmins* group to use Report
Designer. (*This is the default name of the File Reporter administrators group
created during installation of the Engine, which you can change.)

1. Launch the File Reporter 25.3 Report Designer in the Start menu.

2. Enter your login credentials and click Login.

3. Familiarize yourself with the Report Designer interface.
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5 - Report Designer

All Custom Query reports are listed. Those not designed with the Report Designer
Layout interface have a green-banner text icon, while those designed using Report
Designer have a blue notebook icon.

4. Right-click a report to access all toolbar options for that report.

l New Custom Query Report: Launch the Query Editor to create a new Custom
Query report.

l Rename: Change the selected report’s name.

l Copy: Create a copy of the selected report's definition.

l Delete: Delete the selected report.

l Refresh: Reload the list of saved reports.

l Edit Query: Launch the Query Editor to make changes to the SQL query for the
selected report.

l Design Report Layout: Launch the Report Designer Layout interface —see
Custom Query Report Layouts (page 26) for details.

l Clear Report Layout: Delete the custom design settings created for the selected
report using the Report Designer Layout interface (NOTE: Use caution —this
procedure is irreversible).

l Visit Community Portal: Access the File Query Cookbook, a community website
for sharing Custom Query reports and layouts created through the Report
Designer.
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5 - Report Designer

l Access Online Templates: Open the list of all available Custom Query reports
shared on the File Query Cookbook website. From the Custom Query Recipes
page, you can filter your search by category, database host, and more. Simply
copy or download the SQL query from a shared Custom Query report recipe to
use it.

l Filter: The cell directly below the Report Name column heading is a filter that
lists saved reports according to one or more words you enter (e.g., enter the
word access to display only reports with that word in the file name).

l [Report Type]: This box is checked by default to display only Custom Query
reports, which are the only reports that can be designed using the Design Editor.
Uncheck the box to view all of your reports.

l Edit Filter: Further refine your filtering with Boolean operators.

5.2 - Creating a Report

NOTE: Refer to the File Reporter 25.3 Custom Query Guide for details and
examples of the supported database functions, tables, and views you can
utilize in Custom Query reports.

1. Click New Custom Query Report.

2. Enter a descriptive name and click Create to launch the Report Designer Query Editor.
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5 - Report Designer

3. Update the query as desired in the text editor.

4. Click Execute Query to preview the Custom Query report.

5. Click Save.

6. Close the Query Editor.
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5 - Report Designer

5.3 - File System Paths Selector

5.3.1 - Overview

File Reporter includes a File System Paths selector for use with Custom Query reports. This
feature provides:

l An easy-to-use approach to changing target paths for complex Custom Queries.

l A convenient interface to add or change target paths for existing Custom Queries
without modifying any SQL text.

l A powerful interface that enables advanced report users to create manageable report
templates for Data Owners.

l Add the selected path to the target paths list from the tree list.

l Remove the selected path from the target paths list.

l File System: Select to include File System scan paths in the tree list.

l Permissions: Select to include Permissions scan paths in the tree list.

l Save changes made to the target paths list.

l Cancel any current edits.

5.3.2 - Assigning Paths to a Report Definition

To assign one or more file system paths to a Custom Query report definition:
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5 - Report Designer

1. Click the File System Paths ribbon item to open the File System Target Paths
dialog. This ribbon item may be found in the following locations:

l The Edit ribbon page group of the Main form containing the Custom Query
reports list;

l The Parameters ribbon page group of the Query Editor form; and

The Report Data ribbon page group of the Report Layout Designer form.

2. Select one or more target paths by using one of the following methods:

l Double-click a path entry in the tree list on the right.

l Select (highlight) one or more path entries in the tree list on the right then click
Add in the toolbar on the left.

l Drag-and-drop one or more selected path entries from the tree list on the right
into the selected paths list on the left.

3. Click Save.

5.3.3 - Removing Paths from a Report Definition

To remove one or more assigned File System paths from a Custom Query report definition:

1. Open the File System Target Paths dialog. (See Step 1 from Assigning Paths to a Report
Definition (page 23).)

2. Select the paths to remove in the selected path list on the left.

To select a path to remove, select (highlight) the entries for selection then click an
associated check box.

3. Click Remove to remove the selected items from the paths list.

4. Click Save.

5.3.4 - Scan Types

Understanding Scan Type

The File System and Permissions columns in the paths tree list indicate whether the
associated path is available currently as a File System metadata scan entry and/or a
Permissions scan entry.

The paths tree list is populated by data obtained from the most recent File System or
Permissions scans. If a share or path is not visible in the tree list, a new File System or
Permissions scan must be performed before that path will appear.

The path indicator does not determine the type of Custom Query; rather, it indicates which
scan data is available. Depending on the nature of the Custom Query, one or both scan types
may be desired.
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5 - Report Designer

Filter by Scan Type

If a particular Custom Query is defined around data collected solely from either a File System
scan or a Permissions scan, it may be useful to filter the paths tree list by that scan type.

Both scan types are enabled by default, displaying paths from the latest scans of both types.

To filter the list by a specific scan type, deselect the scan type you want to exclude. For
example, to only display paths from current Permissions scans:

1. Uncheck the File System box at the top of the paths tree list.

2. Verify that the Permissions box remains checked.

5.3.5 - Understanding the Relation to Custom Queries

File System Target Paths lists the target paths for the associated Custom Query. How the
Custom Query uses these paths is determined by the associated SQL queries.

While executing a Custom Query, File Reporter injects a temporary table into the SQL session
that provides the select paths along with metadata the SQL query can use to shape the query
results based on those paths —see File System Target Paths in the File Reporter25.3 Custom
Query Guide for details.

5.4 - Report Layout Templates

5.4.1 - Saving the Layout as a Template

When you design a Custom Query report layout you want to use again for future reports, you
can save it as a template:

1. Open the Custom Query report with the desired layout in Report Designer.

2. Select Save As File in the Save menu.

3. Enter a name for the template and click Save to save the layout as a .repx (Report
Definition XML) file.

5.4.2 - Using a Saved Template

You can use saved .repx files as design templates for Custom Query reports.

NOTE: You can also use sample report layouts and SQL queries available from
the File Query Cookbook website (https:/ / filequerycookbook.com), which can
be customized as needed.

1. Open the Custom Query report you want to use with a saved template in Report
Designer.

2. Click Open and select the desired .repx file to apply the design template to your
report.
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5 - Report Designer

5.5 - Custom Query Report Layouts

After creating a Custom Query report through either the Report Designer Query Editor or the
Query Editor built into the browser-based administration interface, you can then design the
report layout.

NOTE: This exercise introduces Report Designer’s basic design features.
Familiarize yourself with these basic features to become proficient enough in
the interface to try more advanced features. Refer to the Report Designer for
WinForms in the following document: https:/ / devexpress.github.io/dotnet-
eud/ reporting-for-desktop/articles/ report-designer/ report-designer-for-
winforms.html for a detailed overview of Report Designer’s features.

1. Select the desired Custom Query report to design from the list.
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5 - Report Designer

2. Click Design Report Layout.

3. Create a report header.

a. Place the pointer in the upper section of the layout grid.

b. Right click and select Report Header in the Insert Band menu. A new Report
Header band appears on the grid.

4. Resize Page 1 and add a page break.

a. Place the mouse pointer on the bottom border of the new band and, using the
vertical ruler as a guide, extend the band to fill the first page (e.g., you can
extend the border down to the 8" mark to fill the first page).
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5 - Report Designer

b. Click and drag a Page Break from the Standard Controls region to the bottom of
the band.

5. Insert and design a chart.

a. Click and drag a Chart from the Standard Controls region to the band to launch
the Chart Designer.
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5 - Report Designer

b. In the Chart Designer below the Chart menu, click the + that pertains to the
Series option and select the Bar option.

c. Click the Data tab and expand Query Results.
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5 - Report Designer

d. Click and drag Category to the Argument cell.

e. Click and drag cat_size to the Value cell.

f. Click the Options tab and replace Series 1 with Category Size in the Name
field.

g. Click the XY-Diagram option below the Chart menu.

h. Check the Rotated box in the Options tab.

i. Select Titles below the Chart menu, then click the +, and select Title.

j. Replace Chart Title in the Lines field under the Options tab with a more
descriptive name (e.g.,File Extensions by Category).

k. Select Category Size below the Chart menu.

l. Click the Properties tab, then scroll down and expand View under the Elements
heading.
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5 - Report Designer

m. Change the Color Each setting to Yes.

n. Click OK.

o. Click the arrow in the upper right-hand corner of the newly-placed chart to
access the Chart Tasks menu, then select Run Designer.
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5 - Report Designer

p. Click the legend and uncheck the Visibility box under the Options tab so that the
legend no longer appears.

q. Click OK.

r. Expand the view of the chart in the Report Designer to take up more of the page.

6. Insert labels.

a. Click and drag Label from the Toolbox to a position centered below the chart.

b. Double-click within the label and specify the label name (e.g.,Total Size).

c. Adjust the font size and style to your preferences.

7. Create new fields.

a. Expand the Query Results from the Field List.

b. Right-click Query Results and select Add Calculated Field.

c. In the Design region of the Property Grid for calculatedField1, change the
(Name) setting to cfTotalSize.

d. While still in the Property Grid, click the ellipses (...) pertaining to the Expression
field under the Data heading to launch the Expression Editor.

e. Select Functions in the bottom-left column.

f. Type sum in the empty field at the top of the middle column to locate the Sum
function, then double click Sum to place the function in the top text box of the
Expression Editor.

g. Select Fields in the bottom-left column, then double-click cat_size in the middle
column.
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5 - Report Designer

h. Click OK to save the new field and close the Expression Editor.

i. Right-click Query Results and select Add Calculated Field.

j. In the Design region of the Property Grid for claculatedField1, change the
(Name) setting to cfTotalSize_String.

k. While still in the Property Grid, click the ellipses (...) by the Expression field under
the Data heading.

l. Type Byte in the top text box of the Expression Editor so that ByteString()
appears.

m. Double-click cfTotalSize you created earlier from the middle column and click
OK.

8. Place the new fields.

a. From the Field List, hold down the Control key and select the two new fields you
just created, then drag them to the Total Size label on the grid.

b. Adjust the size so that both fields appear to the right of the Total Size label.
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5 - Report Designer

c. Adjust the font size and style to your preferences.

9. Preview the report.

a. Click Download All Data.

b. When the warning dialog box appears, click Yes.

c. Click the Print Preview tab to view how the report will look at this point.

d. Make any desired format changes.

10. Create a header for Page 2.

a. Click the Report Designer tab.

b. Scroll down below the page break so that you are working on Page 2 of the
report.

c. Right-click at the top of the page and select PageHeader in the Insert Band
menu.

d. Click and drag a Table from the Tool Box to the location of the new page header.

e. Replace the names of the three new table cells with the following names:

l Category

l Size

l File Count

f. Select and right-click the File Count cell, then select Column to Right in the
Insert menu.

g. Change the table cell name to Percent of Total.

h. Resize the table cells to your preferred width.

i. Adjust the font size and style to your preferences.

j. Resize the depth of the page header so it is limited to the depth of the table.

11. Create a new calculated field for Percent of Total.

a. Right-click Query Results and select Add Calculated Field.

b. Change the (Name) setting for calculatedField1 in the Design region of the
Property Grid to cfPercentofTotal.

c. While still in the Property Grid, click the ellipses (...) by the Expression field under
the Data heading.

d. Double-click cat_string from the middle column of the Expression Editor.

e. Hit the space bar and then enter the following string: * /100.

f. Double-click cfTotalSize from the middle column of the Expression Editor to
complete the string.

g. Click OK.
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5 - Report Designer

12. Insert the table content.

a. Click below the header, hold down the Control key, and from the Field List, select
the following fields in this order:

l category

l cat_size_string

l file_count

l cfPercentofTotal

b. Drag the fields to a location below the header.

c. Line up the tables cells with the headings.
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5 - Report Designer

d. Click the Print Preview tab to view how the report will look.

e. Make any necessary adjustments.

13. Click Save to Database in the Save menu.

By saving the report to the database, you enable the File Reporter Report Generator to use the
design for updated reports. You can also save the report as a file to import it into another file,
such as a Word document or PowerPoint presentation.
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6 - Report Viewer

6 - Report Viewer
View all stored reports locally from a Windows workstation. The Report Viewer utilizes the
workstation’s resources rather than those of the Engine, so it can display stored reports
much faster in most instances.

In comparison to the viewing capabilities of the browser-based administrative interface, the
Report Viewer offers more capabilities. With the Report Viewer, for example, you can change
the visual display parameters of the report.

1. Launch the File Reporter Report Viewer application.

2. Click Open and go to the location of your stored reports, then select the reports folder
and click Open.

To determine where your stored reports are located, select Configuration in the File
Reporter administrative interface, then click Stored Reports to view the location in the
Stored Reports Folder field.
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6 - Report Viewer

3. (Optional) Adjust the view to your preferences using the following tools:

l Bookmarks: Toggle the display for the report Document Map.

l Many Pages: Specify the number of pages to display.

l Zoom Out: Reduce the size of the report page to view more on the screen.

l Zoom: Change the zoom level of the report preview.

l Zoom In: Increase the size of the report page to get a close-up view.

l Page Color: Change the background color of the report pages.

l Watermark: Insert a semi-transparent text or image behind the content of each
page of the report. The Watermark dialog lets you specify your watermark’s
settings.
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6 - Report Viewer

4. (Optional) Save the report using the following tools:

l Save Save the report as a .prnx file which can be opened through the Report
Viewer.

l Export To a new report format. Each selected format option brings up a dialog
to provide specifics on how you want to export the report.
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